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Introduction

This document is a comprehensive guide to installing the MassTransit Web (MTWeb) component provided
with MassTransit Enterprise. MassTransit supports the following features via the web interface: file transfer,
job tickets, log viewing, and password change. MassTransit 5.1 introduces several new features including
Directory Services support, Single Sign-On, Password Complexity, FTP Fallback, and the web client plug-in is
now native on Intel-based Macs. To learn about the new 5.1 resources, please go to the “Other MassTransit
5.1 Resources” section of this document.

MTWeb requires four components — MassTransit Enterprise, MySQL, a web server (IIS or Apache), and PHP.
Please view the latest ReadMe for a comprehensive list of the recommended system requirements located at
http://www.grouplogic.com/files/glidownload/mtreleases.cfm .

Setup Requirements

MassTransit Web requires the following components:

e MassTransit Enterprise version 5.1 or higher
NOTE: You MUST install the MassTransit web site files corresponding to your MassTransit
engine version. MassTransit 5.1 requires version 5.1 web site files.

e MySQL version 5.0.42 is recommended, however, MassTransit 5.1 is compatible with MySQL
4.1.21

e PHP5.2.x

e (WINDOWS) Internet Information Services (1IS) 5 or 6; 6 is recommended.

e (MACINTOSH) Apache1.3 or higher

Along with the above components, MassTransit Web requires one of the following web browsers:
Windows:

e Internet Explorer 5.5 or higher
e Firefox 1.5.0.1 or higher

Macintosh:

e Safari 1.3 or higher
e Firefox 1.5.0.1 or higher

Note on Intel Mac support: MassTransit can be installed and run on Macs that use Intel CPUs. MassTransit is
a PowerPC-based application that runs using Rosetta emulation. MassTransit 5.0.1x29 or later is required to
run MassTransit Pro and Enterprise on Intel Macs. Earlier versions of the MassTransit 5.0 Satellite Server
and Application Client also work on Intel Macs. The MassTransit 5.1 web client plug-in runs natively on Intel-
based Macs.
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MassTransit Web Setup

The MTWeb setup consists of two steps: PHP installation and the Web Server setup. The following sections
provide a comprehensive guide to setting up MTWeb on both Windows and Macintosh operating systems with
specific instructions for IS and Apache. MassTransit Enterprise and MySQL must be installed and running
before configuring MTWeb. See the Installation Guides for Macintosh and Windows included on the CD or
with your download package for assistance. Please follow the steps outlined in the Before You Begin section
below to configure MassTransit for MTWeb.

New Installations and Upgrading MassTransit 4.5 to 5.1

If this is a new installation of MassTransit or you’re upgrading from 4.5.x to 5.1.x, follow all of the instructions
in the Before You Begin section and the Windows or Mac OS X Setup section.

Before You Begin

The following instructions provide steps to configure MassTransit. The MassTransit.cfg and mtweb.ini files
must be configured.

1. Navigate to the Extras folder within the MassTransit directory. Copy the MassTransit.cfg file to the
MassTransit Server 5 directory.

2. Open the MassTransit.cfg file and make sure to uncomment (delete the “%%”) the
ENABLE_SOAP_API and SOAP_API_PORT flags. Set the ENABLE_SOAP_API flag to TRUE.

NOTE: You must restart MassTransit Enterprise for any changes to take affect. On Windows the
MassTransit Engine service can be restarted from the Services control panel. To verify that these
changes have taken effect, launch the MassTransit Administrator and look at the log; a message
appears stating, “SOAP interface enabled on port 50050.”

3. Give READ & WRITE permissions to the user running the web process for the parsed and
templates_c folders which can be found inside the MTWeb directory. On Windows this is normally
the “Internet Guest” or “Anonymous Internet” account. On Mac this should be the Group the Apache
HTTP server is using, default is www. Please consult the FAQ section at the end of this document
for enabling writable permissions on folders.

NOTE: Any time the MTWeb files are updated, you must delete the contents of the parsed and
templates_c folders with the exception of the readme.ixt files.

4. Edit the mtweb.inifile; by default, the file is located inside the MTWeb directory found within the
MassTransit Server 5 folder.

NOTE: All lines beginning with “;” in the mtweb.ini file are considered commented and therefore
ignored. You must uncomment all lines mentioned in the steps below.

a. Enter a valid username and password in the DB_USER and DB_PASSWORD fields
respectively. The username and password created during the MassTransit installation can
be used for MTWeb. The default MySQL installation username is “masstransit”. Please
consult the FAQ for information on creating a new user in MySQL.
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The nex

b. Verify that the following lines in the mitweb.ini file are configured correctly. Please view the
file for detailed definitions of each field.
SOAP_PROXY_ADDRESS
DB_HOST
DB_NAME

t sections provide operating system specific instructions for Windows and Mac OS X operating

systems. They provide details on installing PHP and configuring the Web Server to complete the installation
and setup of MTWeb.

Windows Setup

Follow the steps below to setup MTWeb on Windows. You must first install and configure PHP before setting
up the Web Server using Microsoft Internet Information Services (lIS).

Step 1

: PHP Setup

The steps below provide setup instructions for PHP. The instructions below assume that your operating
system is installed on the “C:\” drive.

1.

‘_-P

Install PHP 5.2.0, which is available at: http://www.grouplogic.com/files/glidownload/mtreleases.cfm .
Use the PHP zip package and extract the package into a directory called php (e.g. “C:\php”). ltis
strongly recommended that PHP be installed on the same drive as the operating system. Installing
PHP on a different drive will prevent MTWeb from working properly.

WARNING: Do NOT use the PHP installer; use only the zip package as stated above.

NOTE: If Stuffit Expander was used to open the PHP zip package and the required PHP files
mentioned below are not present, try using another application to open the PHP zip package.

Copy the php.ini-dist file from the php folder to your system directory (e.g. “C:\Windows\”) and
rename it php.ini.

Open the php.inifile (located in “C:\Windows\") in an application suitable for plain text editing and
continue with the following steps to make changes to the default PHP settings.

NOTE: All lines beginning with “;” in the php.ini file are considered commented and therefore ignored.
Please ensure that all lines mentioned in the steps below are uncommented (if you see a “;” character
at the beginning of any of the lines mentioned below, please delete it).

Change the line beginning with “display_errors =" as shown below.

display_errors = Off

Change the line starting with “doc_root =" as shown below if MassTransit was installed in the default
location.

doc_root = “C:\Program Files\Group Logic\MassTransit Server 5\MTWeb\webroot”

MassTransit
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6. Change the line beginning with “extension_dir” as shown below.
extension_dir = “C:\php\ext”
7. Change the line beginning with “cgi.force_redirect =" as shown below.
cgi.force_redirect = 0
8. \Verify that the php_mysqli.dll library file is included in the “C:\php\ext\” directory.
9. Add the following line(s) to the Dynamic Extensions section of the php.ini file.

extension=php_mysqli.dll
extension=php_soap.dll

10. Change the line beginning with “session.cache_limiter” to blank as shown below.
session.cache_limiter =

11. Create a directory named “tmp” within the PHP folder and then change the line beginning with
“session.save_path” as shown below.

session.save_path = “C:\php\tmp”
12. Edit the following lines to enable PHP logging for troubleshooting purposes:

error_reporting = E_ALL
log_errors = on
error_log = “MT-PHPLog.log”

Please note that for the error log to be written, the Windows user account associated with the 11S
web site that MassTransit will use (generally IUSR_COMPUTERNAME) needs to have write
access to the log file. By default (if you don’t specify a folder), the default log file location will be
your webroot folder. If you do not want to give the Windows user account associated with the IIS
web site full access to a folder, you may create an empty log file with this name manually and
then grant that Windows user account write access to that file only.

13. After completing the above modifications to the php.ini file, please save the file and then close the
application being used to edit the file.

14. Copy the libmysql.dll file from “C:\php\” to “C:\Windows\System32\".

15. Confirm that the PHP installation directory has appropriate system permissions.
® | ocate the directory where PHP has been installed. By default, this directory is C:\php.
® Right-click on this directory, and select “Properties” from the pull-down menu.
® Select the “Security” tab from the PHP Properties window.
[ ]

Confirm that the machine’s “Network Service” user has Read, Execute, and List permissions
for the PHP installation directory.

4-"' _
MassTransit

Page 7 of 22



NOTE: The Network Service user rarely shows up explicitly, but is a member of the Users group.
Depending on the security structure for the particular machine, you may want to add the Users
group to the PHP folder (and propagate permissions downstream to the contained files and
folders), or just add the Network Service user by itself.

More information regarding PHP installation on Windows can be found at
http://www.php.net/manual/en/install.windows.php

PHP setup is now complete. You can verify that PHP is running successfully by consulting the FAQ.

Step 2: Web Server Configuration
Internet Information Services (IIS)

The steps below indicate how to configure MTWeb as the default website in 11S. Please note that IIS is not
installed by default in most Windows installations. For instructions on installing 11S, please refer to:
http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/11IS/750d3137-462¢-491d-b6c7-
5f370d7f26cd.mspx?mfr=true

1. Open the IIS Manager from Control Panel > Administrative Tools.
2. Right Click on the Default Web Site entry located under the Web Sites folder and select Properties.
3. Select the Home Directory tab.

a. Click on the Browse button to specify the webroot folder. For the default MassTransit
installation path is:
C:\Program Files\Group Logic\MassTransit Server 5\MTWeb\webroot
b. Ensure that the ‘Read’ checkbox is checked while the ‘Write’ and ‘Directory browsing’
checkboxes are unchecked.
Change the ‘Execute Permissions’ combo box to “Scripts Only”.
Click on the Configuration button under the Application Settings group.
e. Click the Add button and set the Executable path by clicking on the Browse button. The
default path should be as follows:
C:\php\php5isapi.dil
Enter “.php” in the ‘Extension’ text field (no quotations).
Verify that ‘Script engine’ checkbox is checked. Click OK twice.

oo

« -

NOTE: Steps e through g above must be repeated for each extension that is to be associated
with PHP scripts. Extensions such as .php3 may be required for legacy applications.

4. Go to the HTTP Headers tab.

a. Click the MIME Types button (File Types in Windows XP).
b. Inthe window that appears, click the New button.
c. Type “.dmg” (without quotes) into the Extension field.
d. Type “x-application/applediskimage” (without quotes) into the MIME type field.
e. Click the OK button to save the changes and exit this window.

O
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f.  The information that was entered in the previous window should now appear in the list of
Registered MIME types. Click the OK button to save the changes and exit this window.

5. Go to the Documents tab.
a. Click the Add button and enter “index.php” (no quotations) and click OK. Move the
“index.php” to the top by clicking the Move Up button. Click Apply and OK to close this
window.
6. Skip this step if you are configuring MTWeb on IIS version 5.0 or earlier.
a. Select the Web Service Extensions folder and click on "Add a new Web service extension".
b. Enter “PHP” in the Extension field and click Add.
c. Select the ISAPI file by clicking the Browser button and select following:
C:\php\php5isapi.dil
d. Check "Set extension status to Allowed" and click OK.
7. You must now restart IIS so that the changes made to PHP and IIS settings are properly loaded.
The Web Server configuration is now complete. At this point, the website should be running. You can verify
this by opening up a browser and entering the IP Address of the machine on which MTWeb was configured.

The MassTransit Web login page should appear. You must create a valid web client account in MassTransit
to successfully login.
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Mac OS X Setup

Follow the steps below to setup MTWeb on Mac. You must first install and configure PHP before setting up
the Web Server (Apache).

Step 1: PHP Setup

Go to http://www.grouplogic.com/files/glidownload/mtreleases.cfm and download the appropriate PHP
package for your version of Mac OS X. If you are using a Mac OS X 10.4.x version, Group Logic recommends
using the 5.2.0 universal binary version (runs on both PPC and Intel-based Mac platforms). For additional
information please see the following Knowledge Base article:
http://www.grouplogic.com/knowledge/index.cfm/fuseaction/view/doclD/245 .

1. Double-click the compressed file that was downloaded. That file should automatically be
decompressed and create the PHP installer package file on your desktop.

2. Double-click the installer package and follow the installer directions.

3. Edit the php.ini file. The default installation path is /usr/local/php5/lib/. To get to this folder, select
the Go menu in Finder, click Go to Folder... and enter the path.
a. Open the php.ini file with a standard text editor; root privileges are required to edit this file.
b. Search for magic_quotes_gpc.
c. If magic_quotes_gpc = Off, change Off to On.
d. Save and Close php.ini.

PHP setup is now complete. You can verify that PHP is running successfully by consulting the FAQ.

Step 2: Web Server Configuration

Apache comes pre-installed with most Mac OS X installations. You can find further information about
downloading Apache on Mac OS X at www.apache.org

To setup Apache on Mac OS X, you need to edit the httpd.conf file. It can be found at /etc/httpd/. To get to this
folder, select the Go menu in Finder and click Go to Folder....

1. Edit the line beginning with ‘ServerName’. Uncomment the line if it is commented and put your
server’s IP Address here.

2. Change the line starting with “DocumentRoot” directly below “ServerName” to:
DocumentRoot “/Applications/MassTransit Server 5 Folder/MTWeb/webroot/”

NOTE: The above path is only valid if MassTransit is installed in the default location.
3. Change the line starting with “<Directory “Library/WebServer/Documents”>” to:
<Directory “/Applications/MassTransit Server 5 Folder/MTWeb/webroot/”>
‘_-P
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NOTE: The above path is only valid if MassTransit is installed in the default location.
4. Add “index.php” to the “Directorylndex” line in the following section:

#
# Directorylndex: Name of the file or files to use as a pre-written HTML
# directory index. Separate multiple entries with spaces.
#
<lfModule mod_dir.c>
Directorylndex index.html index.php
</IfModule>

Above line will ensure that index.php will be loaded by default when accessing the website.

5. Restart Apache by typing "sudo apachectl restart” at the command line of the terminal window. You
will need Administrator access to restart Apache.

The Web Server configuration is now complete. At this point, the website should be running. You can verify
this by opening up a browser and entering the IP Address of the machine on which MTWeb was configured.

The MassTransit Web login page should appear. You must create a valid web client account in MassTransit
to successfully login.
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Upgrading an Existing MTWeb 5.0.x Installation to MTWeb 5.1

Due to recent changes and improvements in MTWeb, follow the below steps to smoothly upgrade from an
existing 5.0.x MTWeb installation to 5.1 MTWeb.

Windows Setup

1.

Stop the Internet Information Services (lIS) website that is associated with MTWeb.

2. Upgrade to PHP 5.2. The steps below provide setup instructions for PHP. The instructions below
assume that your operating system is installed on the “C:\” drive.

‘_-P

a.

b.

Prior to installing PHP 5.2, open the php.ini file located in “C:\Windows\” and make a backup
of this file.
Install PHP 5.2.0, which is available at:
http://www.grouplogic.com/files/glidownload/mtreleases.cfm . Use the PHP zip package and
extract the package into a directory called php (e.g. “C:\php”). It is strongly recommended
that PHP be installed on the same drive as the operating system. Installing PHP on a
different drive will prevent MTWeb from working properly.
WARNING: Do NOT use the PHP installer; use only the zip package as stated above.
NOTE: If Stuffit Expander was used to open the PHP zip package and the required PHP files
mentioned below are not present, try using another application to open the PHP zip package.
Copy the php.ini-dist file from the php folder to your system directory (e.g. “C:\Windows\”)
and rename it php.ini. and replace the php.ini file that was backed up.
Open the php.inifile (located in “C:\Windows\”) in an application suitable for plain text editing
and continue with the following steps to make changes to the default PHP settings.
NOTE: All lines beginning with “;” in the php.ini file are considered commented and therefore
ignored. Please ensure that all lines mentioned in the steps below are uncommented (if you
see a “;” character at the beginning of any of the lines mentioned below, please delete it).
Change the line beginning with “display_errors =" as shown below.

display_errors = Off
Change the line starting with “doc_root =” as shown below if MassTransit was installed in the
default location.

doc_root = “C:\Program Files\Group Logic\MassTransit Server 5\MTWeb\webroot”
Change the line beginning with “extension_dir” as shown below.

extension_dir = “C:\php\ext”
Change the line beginning with “cgi.force_redirect =” as shown below.

cgi.force_redirect = 0
Verify that the php_mysqli.dil library file is included in the “C:\php\ext\” directory.
Add the following line(s) to the Dynamic Extensions section of the php.ini file.

extension=php_mysqli.dll

extension=php_soap.dil
Change the line beginning with “session.cache_limiter” to blank as shown below.

session.cache_limiter =
Create a directory named “tmp” within the PHP folder and then change the line beginning
with “session.save_path” as shown below.

session.save_path = “C:\php\tmp”
Edit the following lines to enable PHP logging for troubleshooting purposes:

MassTransit
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error_reporting = E_ALL
log_errors =on
error_log = “MT-PHPLog.log”
Please note that for the error log to be written, the Windows user account associated with
the IIS web site that MassTransit will use (generally IUSR_COMPUTERNAME) needs to
have write access to the log file. By default (if you don’t specify a folder), the default log
file location will be your web root folder. If you do not want to give the Windows user
account associated with the 11S web site full access to a folder, you may create an empty
log file with this name manually and then grant that Windows user account write access
to that file only.

n. After completing the above modifications to the php.ini file, please save the file and then

close the application being used to edit the file.
0. Copy the libmysql.dil file from “C:\php\” to “C:\Windows\System32\”.
p. Confirm that the PHP installation directory has appropriate system permissions.

® | ocate the directory where PHP has been installed. By default, this directory is C:\php.
® Right-click on this directory, and select “Properties” from the pull-down menu.

® Select the “Security” tab from the PHP Properties window.
[ ]

Confirm that the machine’s “Network Service” user has Read, Execute, and List
permissions for the PHP installation directory.

NOTE: The Network Service user rarely shows up explicitly, but is a member of the Users group.
Depending on the security structure for the particular machine, you may want to add the Users
group to the PHP folder (and propagate permissions downstream to the contained files and
folders), or just add the Network Service user by itself.

More information regarding PHP installation on Windows can be found at
http://www.php.net/manual/en/install.windows.php PHP setup is now complete. You can verify that PHP
is running successfully by consulting the FAQ.

3. Update the mtweb.ini file. DO NOT simply drop your old mtweb.ini file in the new MTWeb folder.
Some changes may have been made to the settings in this file and using the newest version ensures
proper operation.

a. Open the mtweb.inifile in a text editor.

b. Open the mtweb.inifile that you backed up from your old installation in a text editor.

Note: The entire MTWeb folder was backed up during the installation of MassTransit 5.1; the
folder exists in the root MassTransit folder and is named:
MTWeb.[datestamp].[timestamp].bak.

c. For each enabled setting in your old mtweb.ini file, uncomment the same setting and set the
value appropriately in the new mtweb.inifile. Settings with a ‘# preceding them are not
enabled.

d. Save the new mtweb.inifile.

4. Carefully update any customized code using the MTWeb back up folder.

5. Update the MassTransit.cfg file. DO NOT leave your old MassTransit.cfg file in the new MassTransit
folder. Some changes may have been made to the settings in this file and using the newest version
ensures proper operation.

a. Open the MassTransit.cfg file in a text editor.
b. Open the MassTransit.cfg file that you backed up from your old installation in a text editor.

4-"' _
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c. For each enabled setting in your old MassTransit.cfg file, uncomment the same setting and
set the value appropriately in the new mtweb.ini file. Settings with a ‘#’ preceding them are
not enabled.

d. Save the new MassTransit.cfg file.

6. Give WRITE permissions to the user running the web process (normally the “Internet Guest” or
“Anonymous Internet” account) for the parsed and templates_c folders which can be found inside
the MTWeb directory. Please consult the FAQ section at the end of this document for enabling
writable permissions on folders.

7. No changes to the IIS configurations are required, however, the MassTransit web client plug-in for
Mac OS X is now packaged as an Apple disk image (.dmg). If your organization has Mac OS X
clients, perform the following steps:

a. Open the IIS Manager from Control Panel > Administrative Tools.
b. Right Click on the Default Web Site entry located under the Web Sites folder and select
Properties.
c. Gotothe HTTP Headers tab.
i. Click the MIME Types button (File Types in Windows XP).
ii. Inthe window that appears, click the New button.
ii. Type “.dmg” (without quotes) into the Extension field.
iv. Type “x-application/applediskimage” (without quotes) into the MIME type field.
v. Click the OK button to save the changes and exit this window.
vi. The information that was entered in the previous window should now appear in the
list of Registered MIME types. Click the OK button to save the changes and exit this
window.

8. Restart the machine. This is required to ensure that all new settings for IS and MassTransit are
properly loaded and to remove any cached versions of the old website that may be in memory.

The Web Server configuration is now complete. At this point, the website should be running. You can verify
this by opening up a browser and entering the IP Address of the machine on which MTWeb was configured.
The MassTransit Web login page should appear. You must create a valid web client account in MassTransit
to successfully login.
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Mac OS X Setup

1. Stop the Apache web server that is associated with MTWeb.
2. Upgrade to PHP 5.2.0.

a. Go to http://www.grouplogic.com/files/glidownload/mtreleases.cfm and download the
appropriate PHP package for your version of Mac OS X. If you are using a Mac OS X 10.4.x
version, Group Logic recommends using the 5.2.0 universal binary version (runs on both
PPC and Intel-based Mac platforms). For additional information please see the following
Knowledge Base article:
http://www.grouplogic.com/knowledge/index.cfm/fuseaction/view/doclD/245 .

b. Double-click the compressed file that was downloaded. That file should automatically be
decompressed and create the PHP installer package file on your desktop.

c. Double-click the installer package and follow the installer directions.

d. Edit the php.ini file. The default installation path is /usr/local/php5/lib/. To get to this folder,
select the Go menu in Finder, click Go to Folder... and enter the path.

i. Open the php.ini file with a standard text editor; root privileges are required to edit
this file.
ii. Search for magic_quotes_gpc.
iii. If magic_quotes_gpc = Off, change Off to On.
iv. Save and Close php.ini.

PHP setup is now complete. You can verify that PHP is running successfully by consulting the FAQ.

3. Update the mtweb.inifile. DO NOT simply drop your old mtweb.ini file in the new MTWeb folder.
Some changes may have been made to the settings in this file and using the newest version ensures
proper operation.

a. Open the mtweb.inifile in a text editor.

b. Open the mtweb.inifile that you backed up from your old installation in a text editor.

Note: If you opted to back up the MTWeb folder during the installation of MassTransit 5.1;
the folder exists in the root MassTransit folder and is named: MTWeb.bak.

c. For each enabled setting in your old mtweb.ini file, uncomment the same setting and set the
value appropriately in the new mtweb.inifile. Settings with a ‘# preceding them are not
enabled.

d. Save the new miweb.inifile.

4. Carefully update any customized code using the MTWeb back up folder.

5. Update the MassTransit.cfg file. DO NOT leave your old MassTransit.cfg file in the new MassTransit
folder. Some changes may have been made to the settings in this file and using the newest version
ensures proper operation.

a. Open the MassTransit.cfg file in a text editor.

b. Open the MassTransit.cfg file that you backed up from your old installation in a text editor.

c. For each enabled setting in your old MassTransit.cfg file, uncomment the same setting and
set the value appropriately in the new mtweb.ini file. Settings with a ‘# preceding them are
not enabled.

d. Save the new MassTransit.cfg file.
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6. Give READ & WRITE permissions to the user running the web process for the parsed and
templates_c folders which can be found inside the MTWeb directory. On Mac this should be the
Group the Apache HTTP server is using, default group is www. To determine which group account
Apache HTTP server is using, go to the /etc/httpd folder and open the httpd.conf file and search for
“Group”. Please consult the FAQ section at the end of this document for enabling writable
permissions on folders.

7. Restart the machine. This is required to ensure that all new settings for Apache and MassTransit are
properly loaded and to remove any cached versions of the old website that may be in memory.

The Web Server configuration is now complete. At this point, the website should be running. You can verify
this by opening up a browser and entering the IP Address of the machine on which MTWeb was configured.
The MassTransit Web login page should appear. You must create a valid web client account in MassTransit
to successfully login.
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MassTransit Web Setup with SSL

Enabling SSL using MTWeb allows for secure data transfer between the MassTransit Enterprise Server and
clients using MTWeb.

To setup MassTransit Web with SSL:
1. Enable the Use Secure Connection To Transfer Files checkbox.

NOTE: The SSL transfer is enabled in the MassTransit Enterprise Server on a per contact basis.
Therefore, this must be followed for all Web Client contacts that require SSL encryption for data
transfer.

2. Edit a Web Client contact entry by selecting the entry from the Contacts window and clicking the ‘Edit’
button.

3. Select the Security tab and locate the Web Privileges section.

4. Check the checkbox labeled Use Secure Connection To Transfer Files and click ‘OK’ to save.

MassTransit Web Setup Using SSL Certificates or HTTPS

Within MassTransit edit the mtweb.ini file located inside the MTWeb directory and change the following line:
WEB_SERVER_SECURE = "true"

This document does not provide information on setting up MTWeb with SSL Certificates or HTTPS on Web
Servers (lIS or Apache). Please contact Group Logic support via e-mail at support@grouplogic.com for more
information.

Other MassTransit 5.1 Resources

Go to http://www.grouplogic.com/files/mt/51/OtherMassTransit51Resources.html for additional articles to help
you set up, configure, and use MassTransit 5.1 and its new features. The Group Logic Knowledge Base
contains many articles that provide detailed information on MassTransit 5.1 and its features and components.
The HTML version of this file, “OtherMassTransit51Resources.html”, is provided with your MassTransit 5.1
CD or with your download package.
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MassTransit Web Setup with Multi-homing

By default MassTransit (MT) listens on all IP Addresses at the specified port. If the machine is configured
with multiple IP Addresses, it is often useful to designate an IP Address for MassTransit and the web server.
This is especially valuable when both the website and the MassTransit server must run on SSL (port 443). In
such cases, you must configure MassTransit with multi-homing.

The figure below provides an example where the MassTransit Server will transfer files using SSL on IP
Address 10.10.2.36 on port 443. The website (MTWeb) will be configured on IP Address 10.10.2.38 on port
443.

MTWeb
|
MTWeb User
MT Transfer
>
MT Enterprise Server
MTWeb User

The setup instructions below are based on the diagram above.
Steps

1. Move the MT IP Addresses.txt file from the Extras folder to the same location as the MassTransit

Engine executable.
2. Edit the file and enter the IP Address that MassTransit should listen on. The MT IP Address.txt file

should look like the following based on the above example:
ssl=10.10.2.36

NOTE: Ensure that the line does not start with “%%”.
3. Edit the mtweb.inifile located in the MTWeb directory and change the following line:
HOST_IP_ADDRESS = “10.10.2.36@443”
The multi-homing setup is now complete. The above setup allows users to access MTWeb via IP Address

10.10.2.38 while the file transfers (communication between MT Server & MT Assistant) will occur on IP
Address 10.10.2.36.
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FAQ

Q: How do | give writable permissions to a folder?
A: Follow the steps below to give writable permissions to a folder:
Windows

‘_-P

1.
2.

Right click on the folder and select Properties.

Click on the Security tab and verify that the appropriate Groups and Users have Full Control. At
a minimum, the Administrator account (local computer) should have Full Control. If a folder
needs to be accessed by a domain user then the domain user must also be given full control.
The web site configured in 1IS for MassTransit use has a specific Windows user account
associated with it to provide anonymous access to the web site. For the MassTransit web system
to function properly, that user account must be granted “write permissions” to the “templates_c”
and “parsed” folders (located within MassTransit’'s “MTWeb” folder). To determine the user
account that the 1IS website associated with MassTransit is using for anonymous access, please
follow these steps:

a. Open “Internet Information Services (lIS) Manager” (Control Panel > Administrative Tools
> Internet Information Services (IIS) Manager).

b. Within the “Web Sites” folder, right click the 1S website name for the site that was
configured for MassTransit use, and then click “properties”.

NOTE: If you do not see the list of websites, you may need to click the plus sign icon to
expand the listing so that it shows all entries

c. Click the “Directory Security” tab, and then under the “Authentication and Access Control”
section, click the “Edit” button.

d. Inthe “Enable Anonymous Access” section, look in the “User Name” field and it will
indicate the user account that is being used by the website in the format: “COMPUTER
NAME\USER ACCOUNT NAME”.

e. Click the “Cancel” button to exit out of the properties screens without making changes.

NOTE: For further information please consult the following Microsoft KB Article:
http://www.microsoft.com/technet/prodtechnol/windows2000serv/deploy/confeat/13w2kadc.mspx

Mac

1.
2.

Select a folder from the Finder and press Apple + | to open the Get Info dialog.

The Group that is configured in the Apache httpd.conf file must be granted “Read & Write”
permissions to the “templates_c” and “parsed” folders (located within MassTransit’s “MTWeb”
folder). To determine which group account Apache HTTP server is using, go to the /etc/httpd
folder and open the httpd.conf file and search for “Group”. The default setting for User and Group
is normally www.

Enable the Read & Write permissions for the Apache Group. In the Get Info dialog under
Ownership & Permissions, click Details to view the current settings for Owner, Group and Others.
To change permissions choose from the drop down menus. If necessary, click the lock icon and,
when prompted, enter the name and password of an administrator user on your computer. Set
the permissions and then close the Get Info window.

NOTE: For further information please consult the following Article:
http://docs.info.apple.com/article.htm|?path=Mac/10.4/en/mh669.html
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Q: How do | obtain permission to write to the httpd folder when running as a non-root user?
A: Follow the steps below:

Choose Go > Go to Folder from the Finder.

Enter “/ete/” in the dialog that appears and click Go.

Select the httpd folder in the finder window that appears.

Choose File > Get Info from the Finder.

Click the triangle in the “Ownership & Permissions” section to expand the details.
Click the lock to allow yourself to change the permissions.

Select the user you are logged in as from the “Owner” pulldown.

Authenticate by entering your password.

Close the Get Info window.

CoNoOGO AWM~

If you are not running as root, also obtain permission to write to the httpd.conffile.

1. Double-click on the httpd folder.

2. Select the httpd.conffile from the httpd folder.

3. Choose File > Get Info from the Finder.

4. Click the triangle in the “Ownership & Permissions” section to expand the details.
5. Click the lock to allow yourself to change the permissions.

6. Select the user you are logged in as from the “Owner” pulldown.

7. Authenticate by entering your password.

8. Close the Get Info window.

Q: How do I create a user for MTWeb in MySQL?
A: You can use the MySQL Administrator to create a user.
Windows
1. Launch the MySQL Administrator and sign on with root privileges.
Select the User Administration option from the left pane and click the ‘New User’ button.
Enter username and password under the Login Information group of the User Information tab.
Select the Schema Privileges tab.
Click on the mtdatabase schemata from the left and apply SELECT privileges by selecting the row
labeled “SELECT” and clicking the ‘<’ (left arrow) button.
Verify that SELECT now appears under the Assigned Privileges column.
Click on ‘Apply Changes’ button located on the bottom right corner. You should now see a newly
created user under the User Accounts group.
8. You must now add a valid host for this user. To do so, right click on the user created above located
in the User Accounts group and select the ‘Add Host from Which The User can Connect’ option.
9. Enter a host name (i.e. IP Address or DNS such as “localhost”) and click ‘OK’.

2
3.
4.
5

No

Mac

1. Launch the MySQL Administrator and sign on with root privileges.

2. Select the Accounts option from the top and click the ‘New User’ button located at the bottom left
corner.

3. Enter the username and password under the Login Information group of the General tab.

4. Select the Schema Privileges tab.

5. Click on the mtdatabase schemata from the left and apply SELECT privileges by selecting the row
labeled “SELECT” and clicking the ‘<’ (left arrow) button.

NOTE: In order to setup MTWeb with this username and password, the above created username and
password must be entered in the mtweb.ini file.
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How do | verify if PHP is installed and configured correctly?
Create a test file with a standard text editor, and place within your web root directory.
The test.php should contain the following line:

<?php phpinfo() ?>

Now open up http://<web directory path>/test.php in your web browser.

: Where are the error messages logged?

Error messages are logged to the webserver's default error log. For IIS, the default is:
C:\WINDOWS\system32\LogFiles.

: Upon login, | get a “Server Connection error”.

There may be several factors causing this error. Verify following settings:
e Make sure privileges are set up right in MySQL corresponding to what's set in mtweb.ini.
e Make sure ENABLE_SOAP_API = TRUE is uncommented (delete “%%”) in MassTransit.cfg

: IS launches with an error saying "Unexpected error 0x8ffe274".

This means that another application is using the TCP/IP port 80. You should either change the port
bindings for the website to a port other than port 80 or you should stop the application that is using port
80 and then start the website from the 1IS manager.

: How do | view the php.ini file configuration?
. In your browser, navigate to the phpinfo.php file, which is included in the MTWeb folder. If configured with

MTWeb as root, you can just go to localhost/phpinfo.php. This will display the configuration information
about PHP. One useful thing is to look at is the "Configuration File (php.ini) Path" to make sure you know
where the active php.ini file is.

: How do | find out the version of MTWeb I'm running?
: Login to your MTWeb using a browser. Change the URL as follows where “masstransit.grouplogic.com” is

the IP Address or DNS fully qualified domain name (FQDN) of your MTWeb server.
http://masstransit.grouplogic.com/index.php?action=General.systeminformation

: Why do | see a blank page when I click on the Log tab?

A: You most likely have a configuration problem relating to PHP or MySQL. Confirm the following:

1. Verify that php_mysql.dll and php_mysqli.dll are being loaded by making sure they are listed on
the phpinfo test page (see steps above). If they are not loaded, make sure they are specified
correctly in php.ini and that the files are in the C:\php\ext directory.

2. Make sure your extensions directory is set to “c:\php\ext”.

3. Make sure the database configuration in mtweb.ini is correct. Verify that you have properly
specified the DB_HOST, DB_NAME, DB_USER, and DB_PASSWORD and that they correspond
to what is specified in MySQL.

4. If you still have problems on Windows, you can try the following:

a. Right click on the My Computer icon and click Properties. Navigate to Advanced\Environment
Variables\System Variables.

b. Locate the "Path" variable.

c. Add ";c:\php" (without the quotes — note semicolon) to the end of the string variable.

d. Next, click the ‘New’ button under ‘System variables’ to create a new system variable.
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e. Under Variable Name, enter “PHPRC” (without quotes).
f.  Under Variable Value, enter “c:\php” (indicating the location to the PHP directory; without
quotes).

g. Click OK to save.
h. Save all configuration changes.

i. Next, open the REGEDIT utility.

j- Goto: HKEY_LOCAL_MACHINE\SOFTWARE.

k. Add a key called "PHP".

I. Inside PHP, add a string value called "IniFilePath" and set its value to "c:\php" (without
quotes).

m. Reboot the machine to ensure the setting is applied.
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